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ZA VA©U SIGURNOST Proèitajte ove kratke upute. Njihovo kr¹enje mo¾e 
biti opasno pa èak i protuzakonito. Vi¹e pojedinosti naæi æete u posebnom 
priruèniku.

SIGURNOST U PROMETU PRIJE SVEGA Dok vozite, ne koristite 
komunikator; najprije zaustavite vozilo.

SMETNJE Svi be¾ièni telefoni podlo¾ni su utjecaju smetnji koje mogu 
umanjiti njihove radne karakteristike.

ISKLJUÈITE TELEFON U BOLNICI Pridr¾avajte se svih propisa i uputa. 
Iskljuèite telefon u blizini medicinskih ureðaja.

ISKLJUÈITE TELEFON U ZRAKOPLOVU Be¾ièni telefoni stvaraju radio 
smetnje. Njihovo kori¹tenje u zrakoplovima je protuzakonito.

ISKLJUÈITE TELEFON NA BENZINSKOJ CRPKI Ne koristite telefon na 
benzinskoj crpki. Ne koristite ga ni u blizini zapaljivih tvari i kemikalija.

ISKLJUÈITE TELEFON NA PODRUÈJU MINIRANJA Ne koristite telefon 
na podruèju gdje se provodi miniranje. Pazite na ogranièenja i dr¾ite se 
svih danih uputa i va¾eæih propisa.

RUKUJTE PA®LJIVO Koristite ureðaj samo u uobièajenom polo¾aju (uz 
uho). Bez potrebe ne dirajte antenu.

KORISTITE OVLA©TENI SERVIS Ugradnju i popravak opreme smije 
obaviti samo ovla¹teni servis.

DODATNI PRIBOR I BATERIJE Koristite samo odobren dodatni pribor i 
baterije. Ne povezujte meðusobno neuskladive proizvode.
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UPUÆIVANJE POZIVA TELEFONOM Zaklopite ureðaj i provjerite je li 
telefon ukljuèen i prikljuèen na mre¾u. Unesite broj telefona zajedno s 
pozivnim brojem, a zatim pritisnite . Za prekid veze pritisnite . Za 
javljanje na poziv pritisnite .

HITNI POZIVI Zaklopite ureðaj. Provjerite je li telefon ukljuèen i prikljuèen 
na mre¾u. Za brisanje zaslona, dr¾ite  nekoliko sekundi. Unesite broj 
hitne slu¾be, a zatim pritisnite . Ka¾ite gdje se nalazite. Ne prekidajte 
vezu dok ne dobijete odgovarajuæe upute.

NAPRAVITE PRIÈUVNE KOPIJE Ne zaboravite napraviti prièuvne kopije 
svih va¾nih podataka.

POVEZIVANJE S DRUGIM UREÐAJIMA Pri povezivanju s bilo kojim 
drugim ureðajem, u priruèniku dotiènog ureðaja prouèite sve va¾ne upute. 
Ne povezujte meðusobno neuskladive proizvode.

MJERE OPREZA S IC ZRAKAMA Ne usmjeravajte IC zrake prema oèima 
i pazite da ne doðe do meðudjelovanja s drugim IC ureðajima.
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Kad otvorite prodajni paket, provjerite sadr¾i li sljedeæe:
• Nokia 9210 Communicator
• Memorijsku karticu
• Ovaj priruènik, Postupak pode¹avanja, Kratki priruènik i Upute za dodatni pribor, 

te Priruènik za dodatne aplikacije
• Bateriju velikog kapaciteta BLL-3
• Punjaè ACP-9
• RS232 prikljuèni kabel DLR-2L
• CD s programom za povezivanje s osobnim raèunalom
• Naljepnice sa serijskim brojem i sigurnosnim kodom komunikatora

Kori¹tenje telefona
Savjet: Za kori¹tenje 

programskih uputa, 
rasklopite ureðaj i pritisnite 
tipku  (pomoæ).

Za upuæivanje i primanje poziva i poruka na va¹ Nokia 9210 Communicator, trebaju 
biti ispunjeni ovi uvjeti:
• telefon mora biti ukljuèen,
• u njega treba biti ulo¾ena odgovarajuæa SIM kartica i 
• morate se nalaziti u podruèju djelovanja be¾iène mre¾e.

Hitni pozivi na meðunarodni broj hitne slu¾be 112 mogu se u nekim mre¾ama 
upuæivati i bez SIM kartice. Provjerite to kod svog mre¾nog operatora.
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Opaska: Sve minijaturne SIM kartice dr¾ite izvan dosega male djece.

1 Zaklopite ureðaj i provjerite je li telefon iskljuèen. Ako je ukljuèen, pritisnite 
.

2 Ako je baterija ulo¾ena u komunikator, izvadite je. Pritisnite zapor pri vrhu 
baterije i izvucite je iz le¾i¹ta. Vidi sliku 1.

Slika 1

3 Umetnite SIM karticu u odgovarajuæi utor: pazite da pozlaæeni kontakti SIM 
kartice budu okrenuti prema dolje te da isko¹eni ugao kartice bude s desne 
strane. Vidi sliku 2.
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Slika 2

Ako je SIM kartica pravilno umetnuta u utor, vidjet æe se isko¹eni ugao, kao ¹to 
je to prikazano na slici 3.

Slika 3
vidi se isko¹eni ugao
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baterija gotovo ili potpuno ispra¾njena, prije nastavka zapoèete procedure 
preporuèljivo je komunikator prikljuèiti na punjaè i zapoèeti s punjenjem 
baterije. 

5 Rasklopite komunikator. Na zaslonu æe se pojaviti poruka dobrodo¹lice i 
provesti postupak samoispitivanja.

6 Nakon zavr¹enog postupka samoispitivanja, ukoliko postoji moguænost biranja, 
moæi æete odabrati odgovarajuæi postav tipkovnice. Kao potvrdu odabranog 
rasporeda, pritisnite OK (U redu).
U suprotnom, na zaslonu æe se pojaviti popis gradova.

Savjet: Svoj grad, 
vremensku zonu te oblik 
zapisa datuma i vremena u 
komunikatoru moæi æete 
kasnije izmijeniti koristeæi 
aplikacije Clock (Sat) i 
Control panel (Odrednik).

7 Pomoæu tipke sa strelicama doðite do naziva svoga grada i pritisnite OK 
(U redu). Nakon toga na zaslonu æe se pojaviti prikaz toènog vremena i datuma.
®elite li potra¾iti odreðeni grad, u polje pri dnu prikaza unesite odgovarajuæi 
naziv.

8 Po potrebi promijenite vrijeme i datum, a zatim pritisnite OK (U redu).

Savjet: Kasnije, pomoæu 
aplikacije Contacts (Adresar) 
svojoj posjetnici mo¾ete 
pridodati i sliku.

9 Nakon toga mo¾ete izmijeniti svoje podatke na posjetnici. Pritisnite OK 
(U redu).
Ako je u va¹ komunikator ulo¾ena ispravna SIM kartica, neki podaci na 
posjetnici mogu biti preuzeti sa SIM kartice. 

10 Na kraju se pojavljuje obavijest o uspje¹no zavr¹enom postupku pokretanja. 
Pritisnite OK (U redu).
Opaska: Ako SIM kartica nije pravilno umetnuta, baterija neæe sjesti u le¾i¹te. 

Ne poku¹avajte silom umetnuti bateriju! Provjerite jeste li SIM karticu 
umetnuli onako kako je prethodno opisano. Ako SIM kartica nije 
pravilno umetnuta, izvadite je iz utora i poku¹ajte ponovo.
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Savjet: Stanje 

napunjenosti baterije 
mo¾ete vidjeti preko 
odgovarajuæe oznake  na 
zaslonu komunikatora 
odnosno telefona.

1 Kabel punjaèa ukljuèite pri dnu komunikatora, kao ¹to je prikazano na slici 4.

Slika 4

2 Prikljuèite punjaè u zidnu utiènicu s odgovarajuæim naponom mre¾e. Tijekom 
punjenja, na zaslonu telefona pojavljuje se oznaka èija se duljina postupno 
poveæava.

3 Baterija je puna onog trenutka kada se oznaka smiri, a na zaslonu se pojave 
èetiri ¹tapiæa. Nakon toga punjaè mo¾ete iskljuèiti iz komunikatora.
Opaska: Tijekom punjenja komunikator smijete slobodno koristiti.
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Savjet: Prelazite li na 
Nokia 9210 Communicator 
sa starijih modela, u 
Korisnièkom priruèniku 
pogledajte poglavlje Opæe 
informacije.

Slika 5

Osnovni elementi raèunalnog podsustava, ukljuèujuæi zaslon, prikazani su na slici 
5. Zaslon se jednostavno ukljuèuje rasklapanjem ureðaja. Na zaslonu se pojavljuje 
zadnja aplikacija iz prethodnog kori¹tenja komunikatora.

Zaklapanjem ureðaja, raèunalni podsustav sprema sve podatke i iskljuèuje zaslon.

Opaska: Nema potrebe za nekim posebnim spremanjem podataka. Kad 
pritisnete Close (Zatvori), prijeðete na neku drugu aplikaciju ili pak 
zaklopite ureðaj, Nokia 9210 Communicator sam æe spremiti sve 
podatke.

Naredbene 
tipke

Tipka sa 
strelicamaIzbornièka tipka

Tipkovnica
Tipka pomoæi

Aplikacijske
tipke

Zaslon
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Aplikacije se pokreæu odgovarajuæim tipkama smje¹tenim na gornjem dijelu 
tipkovnice. Postoje ove aplikacije: Desk (Sustav), Telephone (Telefon), Messaging 
(Poruke), Internet, Contacts (Adresar), Calendar (Kalendar), Office (Dokumenti) i 
Extras (Razno).

Savjet: Pokrenute 
aplikacije mo¾ete odabirati 
u ‘Izborniku zadataka' na 
lijevoj strani izbornièke 
trake.

Za prijelaz na neku drugu aplikaciju, pritisnite odgovarajuæu aplikacijsku tipku. To 
mo¾ete uèiniti èak i za vrijeme poziva. Za pokretanje neke aplikacije nije potrebno 
prekidati prethodnu. Sve aplikacije koje nisu aktivne ostaju u pozadini sve dok ih 
ponovo ne pokrenete.

Dijelovi prikaza

Slika 6

Ova je stavka 
odabrana

Desni okvir. ®elite li ga 
odabrati, pritisnite tipku Tab.

Ovaj je lijevi okvir 
odabran

Pojedinosti o stavci Naredbe koje mo¾ete 
upotrijebiti
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naiðete na uputu da 
'pritisnete Open (Otvori)', to 
zapravo znaèi da trebate 
pritisnuti naredbenu tipku 
uz naredbu s nazivom Open.

Osnovni elementi zaslona prikazani su na slici 6. Naredbe se uvijek vezuju uz èetiri 
naredbene tipke. U priruènicima su naredbe otisnute podebljano, dok su stavke na 
zaslonu i izbornièkoj traci otisnute kurzivom.

Pomiènik pokazuje da postoji vi¹e elemenata nego ¹to ih je trenutno prikazano na 
zaslonu. Sadr¾aj na zaslonu mo¾ete pomicati pomoæu tipke sa strelicama 
smje¹tene u donjem desnom uglu tipkovnice.

Kada je pri dnu zaslona prikazano polje za pretra¾ivanje, moæi æete pomoæu 
tipkovnice unijeti tekst i na temelju njega provesti pretra¾ivanje.

Postoji li u prikazu vi¹e okvira, odabrani æe okvir biti uvijek istaknut.

Za kretanje unutar odabranog okvira te odabir pojedinih stavki, koristite tipku sa 
strelicama.

Za pristup naredbama izbornika, pritisnite izbornièku tipku.

Pode¹avanje
Za pristup Internetu, WAP-uslugama i udaljenom po¹tanskom spremniku potrebno 
je podesiti odgovarajuæe postave. 

Opaska: Kao pomoæ u pode¹avanju navedenih postava, prouèite dokument 
'Postupak pode¹avanja' koji ste dobili u paketu s komunikatorom. Iz 
tog æete dokumenta saznati koje su vam informacije potrebne, kako do 
njih doæi te kako ih unijeti u komunikator. A ¹to je jo¹ i va¾nije, tu se 
unose podaci koji vam mogu zatrebati u buduænosti i koje æete koristiti 
za komunikaciju s davateljima usluga o onim informacijama koje od 
njih trebate dobiti.

1 Na tipkovnici komunikatora pritisnite aplikacijsku tipku Extras (Razno).
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pritisnite Open (Otvori). Nakon toga pojavit æe se tri simbola: Internet access 
(Pristup Internetu), WAP access (Pristup WAP-u) i Mail account (Raèun e-po¹te).

Savjet: Za vi¹e 
pojedinosti, vidi poglavlje 
Extras (Razno) u 
Korisnièkom priruèniku.

3 Odaberite Internet access (Pristup Internetu) i pritisnite Open (Otvori). Otvorit æe 
se dijalo¹ki okvir.

Savjet: Za pomoæ oko 
podataka potrebnih u ovome 
i slijedeæim dijalo¹kom 
okvirima, na tipkovnici 
pritisnite tipku  kako 
biste na zaslonu dobili 
potrebne upute; a 
pogledajte i Korisnièki 
priruènik.

Slika 7

Savjet: Za listanje 
stranica, pritisnite 
izbornièku tipku.

4 Unesite potrebne podatke i pritisnite Advanced settings (Dodatni postavi). 
Otvorit æe se dijalo¹ki okvir sa èetiri stranice.

Slika 8

Na svakoj od tih stranica unesite potrebne podatke. 
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æe se dijalo¹ki okvir.

Slika 9

Tu upisujete IP i DNS adrese.
Za povratak u prikaz s tri simbola, pritisnite Done (Gotovo).

Savjet: Za vi¹e 
pojedinosti, vidi poglavlje 
Internet u Korisnièkom 
priruèniku.

5 Odaberite WAP access (Pristup WAP-u) i pritisnite Open (Otvori). Otvorit æe se 
dijalo¹ki okvir.

Slika 10

Na svakoj od tih stranica unesite potrebne podatke, a za povratak u prikaz s tri 
simbola pritisnite Done (Gotovo).
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pojedinosti, vidi poglavlje 
Messaging (Poruke) u 
Korisnièkom priruèniku.

6 Odaberite Mail account (Raèun e-po¹te) i pritisnite Open (Otvori). Otvorit æe se 
dijalo¹ki okvir sa èetiri stranice.

Slika 11

Na svakoj od tih stranica unesite potrebne podatke, a za povratak u prikaz s tri 
simbola pritisnite Close (Zatvori).

Povezivanje s osobnim raèunalom
Svoj komunikator mo¾ete povezati s odgovarajuæim osobnim odnosno prijenosnim 
raèunalom pomoæu programa PC Suite for Nokia 9210 Communicator koji se nalazi 
na CD-u prilo¾enom u paketu s komunikatorom. CD takoðer sadr¾i upute za PC 
Suite, i to u odjeljku Kori¹tenje Nokia 9210 Communicatora.

Program PC Suite for Nokia 9210 Communicator radi pod operacijskim sustavima 
Windows 95/98, 2000 i NT. On povezuje sustav datoteka komunikatora 
sa sustavom datoteka raèunala èime vam omoguæuje brz i jednostavan prijenos, 
kopiranje, preimenovanje i brisanje datoteka i mapa na i izmeðu komunikatora i 
raèunala.
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sinkronizirati podatke iz aplikacije (podaci iz adresara ili e-poruke) te na raèunalu 
napraviti prièuvnu kopiju podataka. Osim toga, postupak sinkronizacije i stvaranja 
prièuvnih kopija mo¾ete automatizirati tako da se ti postupci obavljaju ili u 
odreðeno vrijeme ili pri uspostavi veze.

PC Suite mo¾ete koristiti i onda kad raèunalo nije povezano s komunikatorom. Kod 
svakog iduæeg povezivanja dvaju ureðaja, izmijenjeni æe podaci biti preneseni 
s raèunala u komunikator i obratno.

UPOZORENJE: Èuvajte se virusa. U komunikator ugraðujte samo onaj softver 
koji ste nabavili iz pouzdanih izvora gdje postoji odgovarajuæa 
za¹tita od virusa. Vidi ’Certificate Management’ (Upravljanje 
potvrdama) u Korisnièkom priruèniku.

Povezivanje komunikatora s raèunalom
1 Koristite li RS-232 kabel, njegov veæi prikljuèak utaknite u serijsku (COM) 

utiènicu raèunala, a manji u utiènicu pri dnu komunikatora. 
2 Koristite li infracrveni ili serijski prikljuèak razlièit od COM1, na programskoj 

traci Windowsa dvaput pritisnite simbol programa PC Suite i odaberite 
odgovarajuæi prikljuèak.

3 Otvorite komunikator.
4 Koristite li infracrvenu vezu, pazite da infracrveni prikljuèak komunikatora bude 

okrenut prema infracrvenom prikljuèku raèunala. Za aktiviranje infracrvene 
veze na svom komunikatoru, pritisnite Chr +  (tipku s oznakom infracrvene 
veze). Vi¹e o aktiviranju infracrvene veze komunikatora naæi æete u Korisnièkom 
priruèniku.

5 Na raèunalu pokrenite program PC Suite. 
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Sustav (Desk)
Grupa aplikacija Desk (Sustav) koristi se za upravljanje i kori¹tenje raznih veza na 
va¹e omiljene aplikacije i programe drugih proizvoðaèa. Te veze mo¾ete stvoriti u 
odgovarajuæim aplikacijama.

Dodavanje veze
1 Otvorite stavku u odgovarajuæoj aplikaciji. 
2 Pritisnite izbornièku tipku a zatim odaberite Add to Desk (Dodaj sustavu).

Pisanje bilje¹ki
1 Pritisnite Write note (Upis bilje¹ke). Otvorit æe se jednostavni ureðivaè teksta.
2 Unesite tekst bilje¹ke.
3 Za spremanje dokumenta pritisnite Close (Zatvori). Nakon toga bilje¹ka æe se 

pojaviti u glavnom prikazu aplikacije Desk (Sustav).

Telefon (Telephone)
Telephone (Telefon) se koristi za primanje i upuæivanje govornih poziva i 
namje¹tanje postava telefona. Za pokretanje aplikacije Telefon rasklopite 
komunikator i pritisnite na tipkovnici aplikacijsku tipku Tel. Mnogo toga ¹to 
mo¾ete napraviti u aplikaciji Telefon, moæi æete napraviti i koristeæi se prednjom 
stranom komunikatora.
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• telefon treba biti ukljuèen,
• u komunikator treba biti ulo¾ena odgovarajuæa SIM kartica i 
• morate se nalaziti u podruèju djelovanja be¾iène mre¾e.

Upuæivanje poziva
Postoje dva osnovna naèina za upuæivanje poziva:
• Iz imenika aplikacije Telefon odaberite osobu i pritisnite Call (Nazovi). Ako za 

dotiènu osobu postoji samo jedan telefonski broj, poziv æe odmah biti upuæen.
Postoji li za tu osobu vi¹e brojeva, pojavit æe se popis svih brojeva; odaberite 
jedan od njih i pritisnite Call (Nazovi).

• U polje za pretra¾ivanje pri dnu glavnog prikaza unesite telefonski broj  i 
pritisnite Call (Nazovi).

Odgovaranje na poziv
Kada vas netko nazove, na zaslonu æe se pojaviti odgovarajuæa obavijest. Osim toga 
mo¾ete èuti i zvonjenje. Za odgovaranje na poziv, pritisnite Answer (Odgovori) ili, 
ukoliko ne ¾elite odgovoriti, pritisnite Reject (Odbaci).

Postav za zrakoplov

Postav za zrakoplov sprjeèava nehotièno ukljuèivanje va¹eg telefona u zrakoplovu. 
Za odabir postava za zrakoplov:
1 U glavnom prikazu aplikacije Telephone (Telefon) pritisnite izbornièku tipku, a 

zatim se izbornièkom vrpcom pomièite sve dok ne doðete do simbola Profiles 
(Skupni postavi)  i odaberite Flight (Zrakoplov).

2 Pritisnite Select (Odaberi).
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potrebna komunikacija s be¾iènom mre¾om. Tako æete, naprimjer, moæi èitati 
prethodno preuzetu elektronièku po¹tu, pisati e-poruke, bilje¹ke, kratke poruke, 
telefaks poruke ili obnoviti svoj kalendar. Kad izaðete iz zrakoplova, postav za 
zrakoplov mo¾ete iskljuèiti pritiskom na Exit profile (Iskljuèi postav). Nakon toga 
mo¾ete ukljuèiti telefon pritiskom na  i va¹e æe SMS poruke, telefaks poruke i 
e-poruke biti automatski odaslane.

Kad je u komunikatoru ukljuèen postav za zrakoplov, hitne pozive morat æete 
upuæivati putem telefona (uz zaklopljeni komunikator):
1 Pritisnite . Na zaslonu telefona stajat æe poruka Flight profile is active.. (Postav 

za ZRAKOPLOV ukljuèen).
2 Dok obavijest jo¹ stoji na zaslonu (¹to traje otprilike pet sekundi), moæi æete 

birati broj hitne slu¾be uprogramiran u va¹ komunikator, naprimjer 112.
3 Pritisnite .

VA®NO! Nikad ne koristite telefon u zrakoplovu. Dopusti li vam osoblje 
zrakoplova kori¹tenje raèunalnog podsustava, OBAVEZNO ukljuèite 
postav za zrakoplov. Taj vam postav dopu¹ta kori¹tenje raèunalnog 
podsustava, ali onemoguæuje kori¹tenje telefona. Ne zaboravite da je 
za sve komunikacijske aplikacije neophodno koristiti telefon.

Poruke (Messaging)
U grupu Messaging (Poruke) spadaju ove aplikacije: Fax (Telefaks), Mail 
(Elektronièka po¹ta) i SMS (Usluga kratkih poruka). Za pokretanje aplikacije 
Messaging pritisnite na tipkovnici aplikacijsku tipku Messaging.

Slanje i primanje telefaks, elektronièkih i kratkih poruka:
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• va¹a mre¾a treba podr¾avati telefaks pozive, podatkovne pozive i SMS,
• usluge za telefaks, podatke i SMS trebaju biti ukljuèene za va¹u SIM karticu,
• od davatelja internetskih usluga treba vam biti omoguæen pristup Internetu 

(IAP - Internet Access Point), a odgovarajuæi postavi za Internet i elektronièku 
po¹tu trebaju biti pode¹eni,

• broj SMS sredi¹ta treba biti upisan u postave SMS aplikacije.

Za vi¹e pojedinosti obratite se svom matiènom davatelju usluga.

Opaska: Sustav elektronièke po¹te za Nokia 9210 Communicator sukladan je 
internetskim standardima SMTP, IMAP4 i POP3.

Pisanje i slanje telefaks, elektronièkih i kratkih 
poruka
Za pisanje, izmjenu i slanje telefaks, elektronièkih i kratkih poruka koriste se 
odgovarajuæi ureðivaèi koje mo¾ete otvoriti na neki od ova tri naèina: 
• Napi¹ite i oblikujte tekst u nekoj od aplikacija koja to omoguæuje. Za slanje 

teksta, pritisnite izbornièku tipku, odaberite najprije File > Send (Datoteka > 
©alji), a zatim jednu od ponuðenih opcija slanja. 

• U glavnom prikazu aplikacije Messaging (Poruke) pritisnite jednu od ovih 
naredbi: Write fax (Pisanje telefaks poruke), Write mail (Pisanje e-poruke) ili 
Write short message (Pisanje kratke poruke).

• U glavnom prikazu aplikacije Messaging (Poruke) pritisnite izbornièku tipku i 
odaberite Write > New message… (Pisanje > Nova poruka...). Zatim odaberite 
odgovarajuæu vrstu poruke.
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Opaska: Za telefaks mo¾ete navesti samo jednog primatelja.

Postoje dva naèina odabira primatelja va¹ih telefaks, elektronièkih i kratkih poruka.
1 U odgovarajuæem ureðivaèu za poruke pritisnite Recipient (Primatelj). Nakon 

toga otvorit æe se dijalo¹ki okvir s popisom osoba.
2 U lijevom okviru potra¾ite jednu ili vi¹e osoba i pritisnite Select (Odaberi).
3 Pritisnite Done (Gotovo).

Druga moguænost je da u zaglavlje telefaks, elektronièke ili kratke poruke 
jednostavno utipkate ime primatelja i provjerite postoji li ono u va¹em adresaru.

Primanje i èitanje telefaks i kratkih poruka
Telefaks poruke primaju se automatski, pod uvjetom da je ova usluga dostupna, da 
je telefon ukljuèen te da se nalazite u podruèju djelovanja be¾iène mre¾e. Kratke 
poruke primaju se automatski, pod uvjetom da je va¹ telefon ukljuèen.

Postoje dva naèina èitanja primljenih telefaks i kratkih poruka:
• Kad na zaslonu dobijete obavijest ili èujete zvono koje upuæuje na pristiglu 

poruku, pritisnite Open (Otvori). Zvono æe se èuti samo pod odreðenim uvjetima.
• Prijeðite u aplikaciju Messaging (Poruke). U ulaznom spremniku, odaberite 

primljenu stavku i pritisnite Open (Otvori). Telefaks odnosno kratka poruka bit 
æe otvorena odgovarajuæim preglednikom.
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Poruku koju vam netko po¹alje komunikator ne prima automatski, nego preko 
udaljenog po¹tanskog spremnika. Za èitanje poruke, najprije morate uspostaviti 
vezu s tim udaljenim po¹tanskim spremnikom, a zatim odabrati poruke za koje 
¾elite da budu prenesene u komunikator. Veza s udaljenim po¹tanskim spremnikom 
uspostavlja se preko podatkovnog poziva.

Uspostava veze s udaljenim po¹tanskim spremnikom

1 U lijevom okviru glavnog prikaza aplikacije Messaging (Poruke) odaberite 
udaljeni po¹tanski spremnik.

2 Odaberite desni okvir i pritisnite Retrieve mail (Preuzmi po¹tu). 
3 Nakon uspostave veze s udaljenim po¹tanskim spremnikom, pritisnite 

izbornièku tipku i odaberite Retrieve > New (Preuzmi > Nove), Selected 
(Odabrane) ili All (Sve) poruke.

4 Kada su sve e-poruke koje ste zatra¾ili preuzete, pritisnite Go offline (Prekini 
vezu).

5 Odaberite poruku koju ¾elite proèitati i pritisnite Open (Otvori).

Internet
Za pristup Internetu: 
• be¾ièna mre¾a koju koristite treba podr¾avati podatkovne pozive,
• usluga prijenosa podataka treba biti ukljuèena za va¹u SIM karticu,
• od davatelja internetskih usluga (ISP) treba vam biti omoguæen pristup 

Internetu (engl. IAP - Internet Access Point), i
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upute u Korisnièkom priruèniku. U karticu 'Postupak pode¹avanja' koju ste 
dobili u paketu s komunikatorom upi¹ite svoje postave.

Od svog æete ISP-a dobiti upute o tome kako podesiti internetske postave. Pa¾ljivo 
slijedite upute.

Opaska: Za pristup Internetu telefon mora biti ukljuèen, morate se nalaziti u 
podruèju djelovanja mre¾e, bez glasovnih odnosno podatkovnih poziva 
u tijeku.

Za uspostavu veze s Internetom:
1 Na tipkovnici komunikatora pritisnite aplikacijsku tipku Internet.
2 Odaberite ¾eljenu aplikaciju, naprimjer WWW, i pritisnite Open (Otvori). Kad 

aplikacija treba uspostaviti vezu, otvara se dijalo¹ki okvir na kojemu stoji 
Connection name (Naziv veze) i Phone number (Broj telefona) pristupne toèke 
Internetu koju koristite za uspostavu veze. 

3 Za uspostavu veze, pritisnite OK (U redu).
4 Za zatvaranje aplikacije, pritisnite Done (Gotovo).
5 Za prekid veze s Internetom, u bilo kojoj od internetskih aplikacija, najprije na 

tipkovnici pritisnite aplikacijsku tipku Internet, a zatim Disconnect (Prekini 
vezu). Istog trenutka veza æe biti prekinuta.

Preglednik za World Wide Web (WWW)
WWW je sustav za pretra¾ivanje i pristup sadr¾ajima na Internetu zasnovan na 
hipertekstu. Za pregled web-stranica:
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je: www.nokia.com.

Savjet: Za pristup svojim 
stranicama, neka web-
odredi¹ta zahtijevaju 
korisnièko ime i lozinku. 
Korisnièko ime i lozinka bit 
æe saèuvani za sljedeæi 
pristup web-stranicama.

1 Pritisnite izbornièku tipku i odaberite File > Open > Web page… (Datoteka > 
Otvori > Web-stranicu)

2 U adresno polje unesite URL adresu ili je odaberite s popisa adresa, a zatim 
pritisnite Go to (Idi na). Do raznih web-odredi¹ta mo¾ete takoðer stiæi iz 
otvorene stranice va¹eg WWW preglednika.

3 Kod se stranica otvori, za odabir veze ili aktivnog podruèja, pritisnite tipku Tab. 
Za kretanje unatrag, koristite tipke Shift+Tab. To mo¾ete uèiniti i kori¹tenjem 
alata Pointer (Pokazivaè) koji se ukljuèuje kombinacijom tipki Ctrl + Q. Vi¹e 
pojedinosti o alatu Pointer naæi æete u Korisnièkom priruèniku.

4 ®elite li prijeæi na neku drugu stranicu ili mjesto, odaberite hipervezu odnosno 
aktivno podruèje i pritisnite Go to (Idi na).

WAP
Aplikacija za pru¾anje WAP-usluga zasnovana je na hipertekstu i koristi se za 
pristup internetskim uslugama koje nude sadr¾aje poput vijesti, vremenske 
prognoze, rasporeda letenja, rjeènika, itd. Namijenjena je mobilnim korisnicima 
s prijenosnim ureðajima.

Za pristup WAP-uslugama: 
• trebate biti unutar podruèja djelovanja mre¾e koja omoguæuje podatkovne 

pozive,
• usluga prijenosa podataka treba biti ukljuèena za va¹u SIM karticu,
• od davatelja WAP-usluga mora vam biti omoguæen pristup WAP-u, i
• moraju biti uneseni odgovarajuæi postavi za WAP. Slijedite odgovarajuæe upute 

u Korisnièkom priruèniku.
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Otvaranje WWW stranice:
1 Pritisnite izbornièku tipku i odaberite File > Open page (Datoteka > Otvori 

stranicu). Otvorit æe se dijalo¹ki okvir. Unesite URL adresu, naprimjer: 
mobile.club.nokia.com.

2 Koristeæi tipku sa strelicama sadr¾aj mo¾ete pomicati, i u njemu odabrati 
hiperveze odnosno aktivna podruèja.
Opaska: Nekim je poslu¾iteljima pristup ogranièen i zahtijeva ispravno 

korisnièko ime i lozinku. U tom æe sluèaju, prije pristupa odreðenoj 
usluzi od vas biti zatra¾eno da unesete svoje korisnièko ime i lozinku.

Adresar (Contacts)
Za pokretanje aplikacije Contacts, pritisnite na tipkovnici aplikacijsku tipku 
Contacts. Aplikacija Contacts namijenjena je za stvaranje, ureðivanje i voðenje 
podataka o osobama, kao ¹to su njihovi brojevi telefona i adrese. Stavke u imeniku 
Contacts nazivaju se posjetnice. Te podatke mo¾ete sinkronizirati s podacima na 
odgovarajuæem raèunalu.

Glavna baza adresara smje¹tena je u memoriji komunikatora. Podatke o osobama 
mo¾ete spremiti i u odvojene baze podataka na prikljuèenoj memorijskoj kartici.

Stvaranje posjetnice
1 U glavnom prikazu aplikacije Contacts, pritisnite New card (Nova posjetnica).
2 Kad se posjetnica otvori, u odgovarajuæa polja unesite podatke.
3 Za spremanje posjetnice, pritisnite Done (Gotovo).
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Glavni prikaz aplikacije Contacts sastoji se od dva okvira, lijevog i desnog. Za 
prijelaz u desni okvir pritisnite Tab. Oznaèite broj telefona dotiène osobe i pritisnite 
Call (Nazovi).

Kalendar (Calendar)
U aplikaciji Calendar (Kalendar), moæi æete provjeriti planirane dogaðaje, sastanke, 
godi¹njice, roðendane, kao i popis poslova koje trebate obaviti. Svim stavkama u 
kalendaru mo¾ete pridru¾iti alarm. Za pokretanje aplikacije Calendar, na tipkovnici 
komunikatora pritisnite aplikacijsku tipku Calendar.

Svoj kalendar i zadatke mo¾ete sinkronizirati s programima Microsoft Windows i 
Lotus, kad svoj komunikator prikljuèite na osobno raèunalo.

Stvaranje stavke u kalendaru
Jedan naèin stvaranja nove stavke u kalendaru jest:
1 Pritisnite izbornièku tipku i odaberite File > New entry (Datoteka > Nova stavka). 

Odaberite vrstu stavke koju ¾elite stvoriti: Appointment… (Sastanak...), Event… 
(Dogaðaj...), Anniversary… (Godi¹njica...) ili Task… (Zadatak...).

2 U polja stranica dijalo¹kog okvira unesite odgovarajuæe podatke.
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Mjeseèni prikaz glavni je prikaz Kalendara. Ukoliko ste u Calendar unijeli podatke 
za odreðeni mjesec, na desnoj strani zaslona vidjet æete popis dogaðaja. Za izmjenu 
dogaðaja:
1 Pritisnite tipku Enter ili Edit day (Izmjena u danu) kako biste pre¹li u desni okvir.
2 Odaberite dogaðaj i pritisnite Edit (Izmjena). Pojavit æe se obrazac 

s pojedinostima.
3 Ako je potrebno, izmijenite podatke za tu stavku.

Tjedni prikaz (Week view)
Tjedni prikaz sadr¾i raspored dogaðaja za odabrani tjedan. Za odabir tjednog 
prikaza, pritisnite Change view (Promjena prikaza) i odaberite Week (Tjedan).

Dnevni prikaz (Day view)
Dnevni prikaz sadr¾i popis stavaka za odabrani dan. Za odabir dnevnog prikaza, 
pritisnite Change view (Promjena prikaza) i odaberite Day (Dan). 

Popisi poslova (Task lists)
U tom prikazu mo¾ete vidjeti jedan popis poslova. Ovakve popise mo¾ete koristiti 
za voðenje podataka o svojim poslovima. Mo¾ete odreðivati rokove i prioritete 
svojih poslova. Takvih popisa mo¾ete imati vi¹e, primjerice, jedan koji se odnosi na 
poslovne, a drugi na privatne obveze. 
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Komunikator sadr¾i i ostale prikaze, kao ¹to su Yearly planner schedule (Godi¹nji 
plan) i Anniversary schedule (Popis godi¹njica).

Dokumenti (Office)
Office (Dokumenti) sadr¾i ove aplikacije: Word (Tekst), Sheet (Tablice), Presentation 
viewer (Preglednik prezentacija) i File manager (Rukovatelj datotekama), a sve su 
one uskladive s operacijskim sustavom Microsoft Windows.

Stvaranje Word dokumenta
Kad otvorite aplikaciju Word (Tekst), bit æe otvoren novi dokument. Odmah mo¾ete 
zapoèeti s pisanjem.

Za spremanje dokumenta, pritisnite Close (Zatvori). Otvorit æe se dijalo¹ki okvir. 
Sada trebate imenovati dokument i odabrati mapu u koju ga ¾elite spremiti.

Tablice (Sheet)
Pomoæu aplikacije Sheet (Tablice) mo¾ete raditi s podacima i spremati ih u 
datoteku koja se naziva radna knjiga. Svaka radna knjiga sadr¾i barem jedan radni 
list. Osim toga, radna knjiga mo¾e sadr¾avati i grafikonske listove. Grafikonski list 
je dokument koji sadr¾i grafikon temeljen na podacima iz radnoga lista.
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Savjet: Za dodavanje 
radnog lista u aplikaciju 
Desk (Sustav), pritisnite 
izbornièku tipku i odaberite 
File > Add to Desk (Datoteka 
> Dodaj sustavu).

Za stvaranje nove radne knjige, pritisnite izbornièku tipku i odaberite File > New 
workbook (Datoteka > Nova radna knjiga).

Za spremanje radne knjige, u prikazu s radnim listom pritisnite izbornièku tipku i 
odaberite File > Save (Datoteka > Spremi).

Za stvaranje novog radnog lista u radnoj knjizi, pritisnite izbornièku tipku i 
odaberite Insert > New worksheet (Umetni > Novi radni list).

Za unos podataka, tipkom sa strelicama najprije odaberite æeliju, a zatim u nju 
poènite unositi podatke.

Kao potvrdu upisa u æeliju, pritisnite Enter, OK (U redu) ili tipkom sa strelicama 
prijeðite na neku drugu æeliju. ®elite li poni¹titi upis, pritisnite Esc ili Cancel 
(Odustani).

Za odreðivanje kategorije kojoj ¾elite da pripada podatak u æeliji, pritisnite 
Function (Funkcija). Postoje ove kategorije: All (Sve), Financial (Financijske), Date 
and time (Datumske i vremenske), Mathematical (Matematièke), Statistical 
(Statistièke), Lookup (Pretra¾ivaèke), Text (Tekstovne), Logical (Logièke) i Information 
(Informacijske). Svakoj od navedenih kategorija pripada odreðeni skup funkcija 
koje mo¾ete vidjeti na popisu uz Function name (Naziv funkcije).

Stvaranje grafikonskog lista

Postoji sedam razlièitih vrsta grafikona: Column (Stupèasti), Stacked column 
(Vi¹eslojni stupèasti), Line (Linijski), Pie (Kru¾ni), Bar (©tapiæasti), Stacked bar 
(Vi¹eslojni ¹tapiæasti) i X/Y scatter (Obièni X/Y).
1 Odaberite podruèje na radnome listu. Podaci iz tog podruèja koristit æe se za va¹ 

novi grafikonski list.
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grafikon). Otvorit æe se dijalo¹ki okvir.
3 Potrebno je odrediti slijedeæe: Chart name (Naziv grafikona), Chart type (Vrsta 

grafikona), 3-D (3D-prikaz), Background colour (Boja pozadine) i Axis colour (Boja 
osi).

4 Za stvaranje novog grafikonskog lista, pritisnite Close (Zatvori), a za 
odustajanje Cancel (Odustani).

Preglednik prezentacija (Presentation viewer)
Za otvaranje prezentacije, u glavnom prezentacijskom prikazu pritisnite Open 
(Otvori) kako biste odabrali i pregledali dokument. Za zatvaranje aplikacije, 
pritisnite Close (Zatvori).

Savjet: Radi boljeg 
prikaza, prezentaciju mo¾ete 
uveæati odnosno umanjiti.

Nakon otvaranja dokumenta, bit æe prikazan gornji dio prvog slajda. Za prikaz 
sljedeæeg slajda, pritisnite Next (Sljedeæi) ili Enter. Za prikaz prethodnog slajda, 
pritisnite Previous (Prethodni). Za pomicanje tekuæeg slajda, koristite tipku sa 
strelicama.

Rukovatelj datotekama (File manager)
File manager (Rukovatelj datotekama) koristi se za rad sa sadr¾ajem i svojstvima 
raznih mapa.

U okviru mape, stablo mo¾e sadr¾avati mape koje pripadaju dvjema korijenskim 
mapama: komunikatora i memorijske kartice. 
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sadr¾i èetiri gotove mape: \Documents\Downloaded\ (Preuzeto), \Documents\Photo 
gallery\ (Foto zbirka), \Documents\Templates\ (Predlo¹ci) i \Documents\Tones\ 
(Tonovi).

U okviru datoteka prikazane su sve datoteke koje se nalaze u mapi trenutno 
oznaèenoj u lijevom okviru. Naziv popisa datoteka pokazuje put do trenutno 
odabrane datoteke. Okvir s popisom datoteka pokazuje i simbol odgovarajuæe 
aplikacije te naziv i datum zadnje promjene datoteke. Datoteke su poredane 
abecednim redom.

Prikaz sadr¾aja mape

1 U lijevom okviru sa stablom mapa odaberite ¾eljenu mapu i pritisnite Open 
(Otvori). 
U prikazu æe se pojaviti sve podmape i datoteke koje pripadaju odabranoj mapi.

2 Za prikaz podmapa ni¾e razine, odaberite mapu i pritisnite Open (Otvori).
3 Za povratak u glavni prikaz, pritisnite Done (Gotovo).

Otvaranje datoteke

1 Odaberite datoteku i pritisnite Open (Otvori). Nakon toga datoteka æe biti 
otvorena u odgovarajuæoj aplikaciji.

2 Za povratak u glavni prikaz, pritisnite Close folder (Zatvori mapu).

Stvaranje novih mapa

1 U glavnom prikazu aplikacije File manager pritisnite izbornièku tipku i odaberite 
File > New folder (Datoteka > Nova mapa). Otvorit æe se dijalo¹ki okvir. 

2 Imenujte novu mapu.
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1 Odaberite mapu ili memoriju u kojoj ¾elite provesti pretra¾ivanje.
2 Pritisnite izbornièku tipku > Tools > Find…. (Alati > Pretra¾ivanje...). Otvorit æe 

se dijalo¹ki okvir. 
3 U polje utipkajte tekst na temelju kojega ¾elite provesti pretra¾ivanje. 
4 Za pobli¾e odreðivanje naèina pretra¾ivanja, pritisnite Options (Dodaci).

Za promjenu vrijednosti stavke s popisa, pritisnite Change (Promijeni). 
Kad ste spremni, pritisnite Close (Zatvori).

5 Za pokretanje pretra¾ivanja, pritisnite Find (Naði).
Za zaustavljanje pretra¾ivanja, pritisnite Stop (Stani).

6 Po zavr¹etku pretra¾ivanja, pritisnite Open (Otvori) kako biste otvorili 
pronaðenu mapu odnosno datoteku.
Za pokretanje novog pretra¾ivanja, pritisnite New find (Naði iznova).

7 Za povratak u glavni prikaz, pritisnite Close (Zatvori).

Razno (Extras)
Na tipkovnici pritisnite aplikacijsku tipku Extras kako biste vidjeli simbole raznih 
aplikacija. Za pokretanje aplikacije, odaberite je pomoæu tipke sa strelicama, a 
zatim pritisnite Open (Otvori). 

S CD-a koji ste dobili zajedno s komunikatorom mo¾ete instalirati dodatne 
aplikacije.

Sat (Clock)
Clock (Sat) pokazuje vrijeme i datum u va¹em gradu i zemlji, kao i u nekoliko drugih 
gradova i zemalja ¹irom svijeta. Aplikacija Clock ukljuèuje i sat za alarm.



©2001 Nokia Mobile Phones. All rights reserved.

29

Za
 p

oè
et

akNamje¹tanje alarma

Savjet: U aplikaciji 
Calendar (Kalendar) mo¾ete 
isto tako namjestiti alarm.

1 U glavnom prikazu aplikacije Clock, pritisnite Alarm clock (Sat za alarm). 
Otvorit æe se prikaz sata za alarm.
Trenutno aktivni alarmi nalaze se na popisu pored sata.

2 Za stvaranje novog alarma, pritisnite New alarm (Novi alarm).
Za izmjenu alarma, pritisnite Edit alarm (Izmjena alarma).
Otvorit æe se dijalo¹ki okvir.

3 Navedite podatke potrebne za alarm kao ¹to je Time (Vrijeme).
4 Za prihvaæanje namje¹tenog alarma, pritisnite Close (Zatvori).

Iskljuèivanje zvuka alarma

Pritisnite Stop (Stani) ili bilo koju drugu tipku na tipkovnici telefona.

Za uti¹avanje alarma na neko vrijeme, pritisnite Snooze (Prièekaj).

Kalkulator (Calculator)
Calculator (Kalkulator) mo¾e raditi na dva naèina: kao stolni kalkulator za 
jednostavne aritmetièke operacije ili kao znanstveni kalkulator za slo¾enije 
matematièke operacije.

Postoje dva naèina obavljanja izraèuna, i to unosom znakova u odgovarajuæe polje 
ili odabirom simbola iz popisa funkcija. Izraèun se provodi pritiskom na tipku Enter 
ili =. Izraèun i rezultat mogu se vidjeti na izlaznom listu s lijeve strane zaslona. Za 
prijelaz izmeðu polja za unos, izlaznog lista i popisa funkcija, pritisnite tipku Tab ili 
Change focus (Promijeni fokus).
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U Control panelu (Odredniku) mo¾ete vidjeti i mijenjati: Data call barring (Prikaz), 
Date and time (Datum i vrijeme), Regional settings (Regionalni postavi), Internet 
access (Pristup Internetu), Profiles (Skupni postavi), Security (Sigurnost), Certificate 
manager (Upravljanje potvrdama), Install/Remove software (Instaliranje/uklanjanje 
programa), Default folder (Poèetna mapa), Memory (Memorija) i About product 
(Informacije o proizvodu).

Izmjene ovih znaèajki utjecat æe na rad komunikatora u svim aplikacijama.

Za otvaranje programa za izmjenu, pomoæu tipke sa strelicama odaberite 
odgovarajuæi simbol i pritisnite Open (Odaberi).

Snimaè (Recorder)
Savjet: Pomoæu Snimaèa 

(Recorder) mo¾ete snimati 
zvukove i govor, i koristiti ih 
kao tonove zvona. Za vi¹e 
pojedinosti vidi Korisnièki 
priruènik.

Recorder (Snimaè) vam omoguæuje snimanje telefonskih razgovora i govornih 
zabilje¹ki. Isto tako omoguæuje vam preslu¹avanje i izmjenu snimljenog zapisa i 
ostalih zvukovnih datoteka.
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Slika 12

Ukljuèivanje telefona
1 Ako je ureðaj rasklopljen, zaklopite ga.
2 Za ukljuèivanje telefona pritisnite i dr¾ite . 

Zatra¾i li se od vas PIN kod, unesite PIN kod koji ste dobili zajedno sa SIM karticom 
i pritisnite tipku  smje¹tenu odmah ispod teksta na zaslonu ‘OK’ (U redu). 

Telefon

Slu¹alica

Sprijeda Straga

Mikrofon
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zabranjena ni onda kada mo¾e prouzroèiti smetnje ili opasnost.

Oznake na zaslonu
Oznake na zaslonu obavje¹tavaju vas o tome ¹to se u telefonu trenutno zbiva. Ni¾e 
opisane oznake vrijede za telefon koji je spreman za uporabu, s tim da korisnik jo¹ 
ni¹ta nije unosio.

NAZIV ili LOGOTIP MRE®E 

- Pokazuje koju mre¾u be¾iène telefonije va¹ telefon trenutno koristi.

 i ¹tapiæi iznad ovog simbola.

- Pokazuje trenutnu jakost signala na mjestu na kojem se nalazite. ©to je broj 
¹tapiæa veæi, to je signal bolji.

 i ¹tapiæi iznad ovog simbola.

- Pokazuje stanje napunjenosti baterije. ©to je broj ¹tapiæa veæi, to je baterija 
punija.

Upuæivanje i odgovaranje na poziv
Za upuæivanje poziva, unesite pozivni broj i broj telefona, a zatim pritisnite .

Za javljanje na poziv pritisnite .

Za prekid veze pritisnite . 
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Za prijelaz izmeðu skupnih postava.

 Za listanje izbornika, podizbornika i postava. Ako nema aktivnih 
poziva, tipke za pomicanje mo¾ete koristiti za listanje sadr¾aja memorije. Kad je 
poziv u tijeku, tipke za pomicanje koriste se za ugaðanje glasnoæe.

 do  Brojevne i slovne tipke. Za pozivanje svog spremnika glasovnih 
poruka, pritisnite i dr¾ite . 

 Koristi se za posebne funkcije. Ako ste pretplaæeni na dvije telefonske 
linije, s jedne na drugu mo¾ete prelaziti pritiskom i dr¾anjem tipke . 

 Funkcija ovih dviju vi¹enamjenskih tipki mijenja se u skladu s tekstom 
u donjem dijelu zaslona.

Opaska: Slu¹alica i mikrofon nalaze se na stra¾njoj strani ureðaja.

Forum Nokia
Nokia Wireless Data Forum je web-usluga za one koji se bave razvojem aplikacija 
i usluga za Nokijine platforme. Ove web-stranice pru¾aju informacije o raznim 
razvojnim moguænostima poput programa marketin¹ke potpore razvojnim 
timovima, sistem integratorima i ostalim Nokijinim partnerima.

Osim toga, Nokia Wireless Data Forum pru¾a potporu za Nokia 9210 
Communicator kao i ostale Nokijine be¾iène ureðaje za prijenos podataka. 
Web-stranice sadr¾e dokumente, upravljaèke programe, kratke priruènike, podatke 
o kompatibilnosti itd.
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web-stranice sadr¾e dokumente o raznim tehnologijama be¾iènog prijenosa 
podataka.

Nokia Wireless Data Forum mo¾ete naæi na adresi http://www.forum.nokia.com

Club Nokia
Club Nokia pomoæi æe vam da svoj Nokia telefon iskoristite ¹to bolje. Kao èlan 
Cluba Nokia, ostvarujete èitav niz ekskluzivnih pogodnosti. Tu spadaju brza usluga 
i potpora, prikazi novih Nokijinih proizvoda, posebne ponude, pristup 
web-stranicama Club Nokia i jo¹ mnogo toga.

Imate li kakvih pitanja, pomoæi æe vam netko od struènjaka za Nokia telefone. 
Omoguæen vam je i jednostavan pristup telefonskoj slu¾bi za potporu Club Nokia 
Careline. Osim toga omoguæen vam je jednostavan pristup do Club Nokia Instant 
Service, na¹eg jedinstvenog uslu¾nog centra za registrirane èlanove Cluba Nokia. 
Uslu¾ne punktove Cluba Nokia mo¾ete naæi diljem Europe. 

Svim uslugama Cluba Nokia, informacijama o proizvodima, posebnoj ponudi, 
novitetima i nagradnim igrama mo¾ete br¾e i lak¹e pristupiti putem web-stranica 
Cluba Nokia. Club Nokia dostupan je u veæini europskih zemalja - postanite 
njegovim èlanom veæ danas. Club Nokia naæi æete na adresi 
http://www.club.nokia.com.
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pribor

Savjet: Originalni Nokijin 
dodatni pribor pokriva 
¹iroku lepezu razlièitih 
uvjeta kori¹tenja: dodatnu 
opremu za prijenos 
podataka, praktiène 
naglavne slu¹alice te 
punjaèe i dr¾aèe za mobilno 
kori¹tenje, ali i za kori¹tenje 
u uredu.

Originalni Nokijin dodatni pribor osigurava najbolje funkcioniranje va¹eg 
pokretnog telefona Nokia u razlièitim prilikama. Dodatni pribor za Nokia 9210 
Communicator prilagoðen je raznim tipovima korisnika i raznim komunikacijskim 
potrebama.

Opaska: Koristite samo one baterije, punjaèe i dodatni pribor koji su za ovaj 
model odobreni od proizvoðaèa komunikatora. Kori¹tenjem drugih 
modela prestat æe va¾iti svaki atest odnosno jamstvo za komunikator, 
a osim toga to mo¾e biti i opasno.
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Baterija velikog kapaciteta BLL-3

Slika 13

Baterija velikog kapaciteta BLL-3 tanka je, sna¾na i trajna litij-ionska baterija od 
1300 mAh. Ova vam baterija, ovisno o naèinu kori¹tenja, omoguæuje 4-10 sati 
razgovora te 80-230 sati u stanju èekanja.

Nokia 9210 Communicator zajedno s baterijom te¾i 244 g.
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Slika 14

Savjet: Ovaj je punjaè 
posebno prikladan za one 
koji dosta putuju.

Brzi punjaè ACP-9 lagani je i trajni punjaè koji radi s veæinom izvora napajanja 
razlièitih napona. Za vrijeme punjenja komunikator mo¾ete koristiti na uobièajeni 
naèin. Kori¹tenjem ovog punjaèa, punjenje komunikatora traje otprilike 180 
minuta (ovisno o stanju napunjenosti baterije).

Europska izvedba Izvedba za Veliku 
Britaniju
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Savjet: Za punjenje 
baterija pomoæu ovog stalka 
potreban vam je brzi punjaè 
ACP-9. Za povezivanje 
s raèunalom potreban vam 
je RS-232 prikljuèni kabel 
DLR-2L. Vezu s raèunalom 
mo¾ete ostvariti i be¾iènim 
putem.

Slika 15

Pro¹ireni stolni stalak DCH-10 omoguæuje jednostavano
• punjenje baterije kada je ona prikljuèena na komunikator,
• povezivanje na odgovarajuæe raèunalo radi prijenosa podataka.

Na lijevoj strani stalka nalazi se infracrveni prikljuèak (vidi sliku 15). Stalak ima i 
utor za punjenje baterija izvaðenih iz komunikatora, ¹to predstavlja posebnu 
pogodnost za punjenje prièuvnih baterija. 

Punjenje baterije u komunikatoru pomoæu stolnog stalka

1 Na stalak prikljuèite brzi punjaè ACP-9.
2 Komunikator s baterijom i prikljuèkom prema dolje najprije umetnite u stolni 

stalak.
3 Prikljuèite punjaè na zidnu utiènicu.

utor za punjenje 
prièuvne baterije

infracrveni 
prikljuèak
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1 Na stolni stalak prikljuèite brzi punjaè.
2 Prièuvnu bateriju s pozlaæenim prikljuècima okrenutim prema dolje umetnite u 

drugi utor. Najprije bateriju pritisnite prema dolje i lagano je gurnite prema 
natrag dok ne ¹kljocne i sjedne na svoje mjesto.

3 Prikljuèite punjaè na zidnu utiènicu. Lampica na lijevoj strani punjaèa treba biti 
upaljena. Crveno svjetlo oznaèava da proces punjenja jo¹ traje. Kad se baterija 
napuni, pojavit æe se zeleno svjetlo.

4 Izvadite bateriju tako da je gurnete prema naprijed i podignete sa stalka.
Opaska: Ako se na stalku nalazi i komunikator, tada æe punjenje prièuvne 

baterije biti prekinuto sve dok baterija u komunikatoru ne bude 
potpuno napunjena.

Povezivanje s raèunalom

Za povezivanje s raèunalom koristite RS-232 prikljuèni kabel DLR-2L, i to ovako:
1 Jedan kraj kabela utaknite u prikljuèak na stra¾njoj strani stalka.
2 Drugi kraj kabela spojite na raèunalo. 
3 Komunikator s prikljuèkom prema dolje umetnite u stalak.
4 Na raèunalu pokrenite program PC Suite for Nokia 9210 Communicator ili 

aplikaciju Fax/Modem (Telefaks/Modem).

Osim kabelske mo¾ete koristiti i infracrvenu vezu, i to ovako:
1 Provjerite je li infracrvena veza ukljuèena na komunikatoru i na raèunalu. 
2 Komunikator s prikljuèkom prema dolje umetnite u stalak.
3 Infracrveni prikljuèak stalka usmjerite prema infracrvenom prikljuèku raèunala. 

Udaljenost izmeðu dva prikljuèka ne bi smjela prelaziti 30 cm.
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aplikaciju Fax/Modem (Telefaks/Modem).

Podatke izmeðu svog komunikatora i odgovarajuæeg programa na raèunalu mo¾ete 
sinkronizirati jednim pritiskom tipke . Vi¹e pojedinosti naæi æete u Uputama za 
PC Suite (odjeljak Kori¹tenje Nokia 9210 Communicatora) koje se nalaze na CD-u 
koji ste dobili zajedno s komunikatorom.
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Pro¹irena instalacija za automobil CARK109

Slika 16

Savjet: Vrijeme punjenja 
baterije isto je kao kod brzog 
punjaèa ACP-9.

Pro¹irena instalacija za automobil CARK109 omoguæuje kori¹tenje komunikatora u 
automobilu bez uporabe ruku. Instalacija za automobil omoguæuje punjenje va¹eg 
komunikatora. Ugradnju opreme u automobil treba obaviti struèna osoba. 
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Slika 17

Instalacija se sastoji od pro¹irenog aktivnog dr¾aèa CRM-1 (prikazan na slici 17), 
pro¹irene jedinice za rad slobodnih ruku HFU-2, mikrofona HFM-8 i vanjskog 
zvuènika HFS-12. Osim toga, za razgovor u diskreciji mo¾ete koristiti i dodatnu 
slu¹alicu HSU-1, a za bolji prijam i rad antenu AMD-2 (oba se ova dodatka mogu 
nabaviti posebno). 

Stavljanje komunikatora na dr¾aè

1 Zaklopite komunikator i zakrenite antenu u zatvoren polo¾aj.
2 Komunikator s prikljuèkom prema dolje umetnite u dr¾aè.
3 Pazeæi da ne o¹tetite prikljuèke, pritisnite komunikator lagano prema dolje sve 

dok ga prihvatni mehanizam ne uèvrsti.

Upuæivanje poziva iz vozila

1 ®eljeni broj utipkajte preko tipkovnice ili, pak, taj broj odnosno ime potra¾ite 
koristeæi funkciju pretra¾ivanja.

2 Pritisnite . Za diskretan razgovor podignite slu¹alicu, ako je ugraðena.

Odgovaranje na poziv

1 Pritisnite , ili, ako je ugraðena slu¹alica, podignite ju.
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dolazne pozive automatski odgovoriti.

Prebacivanje razgovora preko slu¹alice na razgovor bez uporabe 
ruku

Pritisnite jednom tipku Options (Opcije) i u roku od 5 sekundi vratite slu¹alicu na 
mjesto. Ne pritisnete li Options (Opcije) prije vraæanja slu¹alice, veza æe biti 
prekinuta.

Prekid razgovora

Pritisnite , ili, ako je ugraðena slu¹alica, vratite je na mjesto.

Kontakt pri paljenju

Kontakt pri paljenju omoguæuje da se komunikator, dok se nalazi na dr¾aèu, 
automatski ukljuèuje i iskljuèuje ovisno o tome je li vozilo upaljeno ili nije. Time je 
izbjegnuta moguænost da komunikator isprazni akumulator automobila, dogodi li 
se da sluèajno ostaje ukljuèen na dulje vrijeme.

Kad je moguænost kontakta pri paljenju jednom ugraðena, ona postaje trajna. Ne 
¾elite li ovakvu pogodnost, zatra¾ite od dobavljaèa da je ne ugraðuje.

Kad ugasite automobil na zaslonu æe se pojaviti obavijest ‘Phone will power off, if 
not used’ (Ako ga ne koristite, telefon æe biti iskljuèen). Komunikator æe biti 
iskljuèen za 15 sekundi, ako u tom vremenu ne pritisnete neku tipku ili ne izvadite 
komunikator iz dr¾aèa.
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Omoguæuje uti¹avanje auto-radija za vrijeme trajanja telefonskog poziva, ako va¹ 
auto-radio podr¾ava takvu moguænost. Pri ugradnji, od svog dobavljaèa zatra¾ite 
ukljuèenje navedene opcije.

Upravljanje motorom antene

Kad je ova opcija ugraðena, ukljuèivat æe elektromotor pokretne antene.

Punjaè na upaljaè za cigarete LCH-9

Slika 18

Punjaè na upaljaè za cigarete LCH-9 omoguæuje jednostavan i prikladan naèin 
punjenja baterije komunikatora u vozilu. Prikladan je za veæinu upaljaèa za 
cigarete. Izvod iz punjaèa utaknite u utiènicu pri dnu komunikatora.
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Naglavna slu¹alica HDC-8L

Slika 19

Naglavna slu¹alica HDC-8L omoguæuje razgovor u diskreciji. Daljinskom 
upravljaèkom tipkom, smje¹tenom na mikrofonskom dijelu naglavnih slu¹alica 
mo¾ete odgovoriti na poziv odnosno prekinuti razgovor. Slu¹alice se prikljuèuju na 
utiènicu smje¹tenu u donjem dijelu komunikatora.
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Slika 20

Kopèa za remen BCH-17 omoguæuje vam jednostavno no¹enje komunikatora i 
osigurava da vam je on uvijek nadohvat ruke.

Torbica za mobitel

Slika 21

Torbica je posebno dizajnirana za Nokia 9210 Communicator. Mo¾ete je nabaviti 
kod Nokijinih dobavljaèa.
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Memorijska kartica
Memorijska kartica velièine po¹tanske marke nudi izmjenjivu memoriju za va¹ 
komunikator. Memorijskom karticom poveæava se raspolo¾iva kolièina memorije za 
podatke i programe. Na taj æete naèin u komunikator moæi uèitati nove aplikacije 
i spremiti datoteke koje sadr¾e slike, zvuk u wav zapisu, faksove i dokumente. 
Memorijsku karticu moæi æete koristiti i za razlièite aplikacije ili adresare.

Opaska: Memorijske kartice za Nokia 9210 Communicator ne mogu se koristiti 
u starijim modelima Nokijinih komunikatora, meðutim, kartice za 
Nokia 9110i Communicator se nakon formatiranja mogu koristiti u 
modelu 9210.
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Slika 22

Ovaj prilagodljivi prikljuèni kabel omoguæuje vam da za prijenos podataka 
jednostavno svoj Nokia 9210 Communicator pove¾ete s raèunalom. Prikljuèuje se 
na RS-232 serijski prikljuèak odgovarajuæeg raèunala. Mo¾e se koristiti i 
s pro¹irenim stolnim stalkom DCH-10.


